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Revision History

* Reflects the date document was changed, which may not coincide with software release date.

Revision Date* Description

A November 3, 2005 Minor changes
B December 1, 2005 Minor changes
C January 13, 2006 Added MySQL parameter instructions
D February 22, 2006 Minor changes
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IMPORTANT NOTE:  
This document was developed to help DigiVoice System Administrators determine probable
causes/solutions for some issues based on hardware configuration and software version. If you are
unsure about performing any operation listed here, please telephone Technical Support.

• This document includes troubleshooting information for all Version 4 releases of our
product.  (Note: VoiceLogger became Davacord in versions 3.0.2 and later.)

• This document assumes you are using the version of Adobe Acrobat found on the
DigiVoice CD.

• Depending on your operating system, some of the steps described in this document
may be slightly different from what you must perform on your system.

• For questions regarding driver versions, refer to the Telephony Driver Release Chart
chart located at the end of this document. This chart contains telephony driver release
information for all versions of DigiVoiceXE software.

HINT: Examine the Application Event Log and other system
event logs when errors occur to determine if the cause of the error
and possible solution are evident.

HINT: Each section in this document is categorized by symptom.
A symptom is shown in bold the first time it is listed. If applicable
to your software version and/or hardware, try that solution first. If
that fails to resolve the issue, try the next solution on the list that
matches your symptom, software and/or hardware.

Some issues might apply to more than one section of this document. For
example, if a channel shows No Line in active.Console, a solution may be
listed in the active.Console section or the No Line section.  If you don’t see
your issue listed in one section, review the other sections.
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Search the Troubleshooting Guide
Enlarge or shrink help pages by clicking the - or + sign in the toolbar.  

To search the document, click the binoculars icon on your Acrobat toolbar.  (If you do not
see binoculars, download the Adobe Acrobat version included on your DigiVoice CD.)

When you click the binoculars icon, enter a word or phrase you want to find.  Select the current
PDF document, then click Search. For example, to see all troubleshooting tips that contain the
word recording, type recording. Click Search.
  

Acrobat jumps to the next appearance of the word recording in the document and highlights the
word.  On the right is a summary of your search results showing the number of times the words
was referenced.  Click one of the blue links to jump to a reference.
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ACTIVE.AGENT ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Can’t connect 

to database on 
login

Network issues for 
client machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Network issues for 
server machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Data server down Verify data server is running. If not, 
restart.

Any Any Can’t connect to 
database on login

Data server down MySQL service stopped. Verify 
MySQL service is running. If not, start 
it. (See Start and Stop Services).

Any Any Can’t connect to 
database on login

Corrupt table Run DvCon to repair the table

Any Any Slow to launch Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters section.

Any Any Slow to launch Network issues Resolve network issues

Any Win98 Hot Key 
combinations 
don’t work

Known issue (508)  
Some 
combinations 
don’t work  with 
Windows 98.

Fully test desired key combinations 
before placing into operation.

Any Win98 Client device 
start/stop keys 
don’t work

Incompatibility 
with other 
software

Others programs may be running that 
are not passing on the key presses you 
are capturing. Remove the other 
software or use different start/stop keys.

Any Any Options are 
disabled

Client license 
exceeded

When active.Agent client license is 
exceeded, all options are disabled 
except About, the User’s Manual, and 
Exit.  Contact Technical Support.
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Vers Hardware Symptom Possible Cause Solution

Any Any Options are 
disabled

All recording 
servers down OR 
network problems 
for recording 
services

Verify recording service is running. If 
so, resolve network problems.

Any Any running 
Windows 
XP

Icon not always 
visible in system 
tray

Windows XP may 
hide icons not used 
frequently

Right-click on the system tray and 
select Properties. On the Taskbar tab, 
click Customize. Beside the 
active.Agent icon, select Always Show 
and click OK.

Any Any Icon indicates 
no license

Data server down 
OR hasn’t 
received license 
from recording 
server

Verify data service is running.
Close other active.Agent applications to 
free a license.

Any Any Channel shows 
Disconnect or 
Connected for 
extended period

See CONNECTION ISSUES

Any Any Channel shows 
Disconnect or 
Connected for 
extended period

No assigned 
channel OR free 
agent seating is not 
set up

Check with system administrator to 
ensure correct channel assignment OR 
to verify free agent seating is set up and 
enabled.

Any Any Accounts list 
slow to load 
and/or 
active.Agent 
locks up

Known issue 
(2641) due to large 
accounts list

Launch active.Web and disable 
Accounts list.

Any Any Other 
active.Agent 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD. 
Also, see GENERAL ISSUES.  Contact 
Technical Support
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ACTIVE.CONSOLE ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Can’t connect 

to database on 
login

Network issues for 
client machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Network issues for 
server machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Data server down Verify data server is running. If not, 
restart.

Any Any Can’t connect to 
database on login

Data server down MySQL service stopped. Verify 
MySQL service is running. If not, start 
it. (See Start and Stop Services).

Any Any Can’t connect to 
database on login

Corrupt table Run DvCon to repair the table

Any Any Slow to launch Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters section.

Any Any (client 
or server 
machines)

Slow to launch NIC taking too
long to detect
speed of network
correctly

Set to manually detect network speed by 
changing properties of network card. 
Caution: You must know the speed of 
your network so the settings match. 
Contact your system administrator for 
this information.

Any Any No toolbar 
found 

User moved the 
dockable tool bar 
and closed it OR 
toolbar not 
selected in View 
menu

Select View>Toolbars>Toolbar from the 
active.Console menu bar. Toolbar 
should reappear in its most recent 
location.
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Vers Hardware Symptom Possible Cause Solution

Any Cybertech 
Parrot

Channel 
showing No 
Line won’t turn 
off in 
active.Console

By design Resolve No Line issue.

Any Any Channel won’t 
turn on in 
active.Console

Someone turned 
off channel using 
the Record on 
Demand feature

Check with probable user(s) to see if 
channel turned off.

Any Any Channel won’t 
turn off in 
active.Console

Someone turned 
on channel using 
the Record on 
Demand feature

Check with probable user(s) to see if 
channel turned on.

Any Any Channels show 
Disconnect or 
Connected for 
extended period

See CONNECTION ISSUES

Any Any Can’t connect 
to one or more 
services 

in active.Console

Norton Internet
Security may be
enabled, blocking
traffic 

If listening sockets are available but no 
connection can be established, disable 
Norton Internet Security OR configure 
it to allow communications wit our 
ports (3410, 3400, 3420, 3306)

Any Any Other 
active.Console 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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ACTIVE.MONITOR ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Can’t connect 

to database on 
login

Network issues for 
client machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Network issues for 
server machine 

Resolve network issues

Any Any Can’t connect to 
database on login

Data server down Verify data server is running. If not, 
restart.

Any Any Can’t connect to 
database on login

Data server down MySQL service stopped. Verify 
MySQL service is running. If not, start 
it. (See Start and Stop Services).

Any Any Can’t connect to 
database on login

Corrupt table Run DvCon to repair the table

Any Any Channels show 
Disconnect or 
Connected for 
extended period

See CONNECTION ISSUES

Any Any (client 
or server 
machines)

Slow to launch NIC taking too
long to detect
speed of network
correctly

Set to manually detect network speed by 
changing properties of network card. 
Caution: You must know the speed of 
your network so the settings match. 
Contact your system administrator for 
this information.

Any Any Own channel or 
user missing

By design, as most 
people don’t want/
need to monitor 
their own channel

In active.Monitor (Settings), choose to 
show your user/channel

Any Any using 
Windows 
Terminal 
Server

No audio when 
monitoring 
channels

Special settings 
required on server 
and client machine 
in a WTS 
environment

See the Windows Terminal Server 
section in System Setup Guide

Any Any Other 
active.Monitor 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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ACTIVE.WEB ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Error: Page 

cannot be 
displayed

Network issues for 
client machine 

Resolve network issues

Any Any Error: Page 
cannot be 
displayed

Network issues for 
server machine 

Resolve network issues

Any Any Error: Page 
cannot be 
displayed

Data server down Verify data server is running. If not, 
restart.

Any Any Error: Page 
cannot be 
displayed

Data server down MySQL service stopped. Verify 
MySQL service is running. If not, start 
it. (See Start and Stop Services).

Any Any Error: Page 
cannot be 
displayed

Corrupt table Run DvCon to repair the table.

Any Any Can’t connect 
to database on 
login

Database down Verify data server is running. If not, 
restart.

Any Any Slow to launch Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters section.

Any Any using 
Windows 
Terminal 
Server

No audio when 
playing 
recordings

Special settings 
required in a WTS 
environment

See the Windows Terminal Server 
section in System Setup Guide for 
special settings on server and client 
machine
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Vers Hardware Symptom Possible Cause Solution

Any Any active.Web 
error: 
active.Web not 
licensed
You are not 
currently licensed 
for active.Web

Norton Internet
Security may be
enabled; data
service can’t get
license from
recording service

If listening sockets are available but no 
connection can be established, disable 
Norton Internet Security OR configure 
it to allow communications wit our 
ports (3410, 3400, 3420, 3306)

Any Any Cannot access 
evaluation 
section

License not 
received by 
active.Web 
because data 
service is stopped 
OR data service 
hasn’t received 
license OR not 
licensed for this 
feature

Verify data service is running (see Start 
and Stop Services).  Contact Technical 
Support or a sales agent about features 
that require an additional license.

Any Any Cannot access 
CTI

License not 
received by 
active.Web 
because data 
service is stopped 
OR data service 
hasn’t received 
license OR not 
licensed for this 
feature

Verify data service is running (see Start 
and Stop Services).  Contact Technical 
Support or a sales agent about features 
that require an additional license.

Any Any Pages don’t 
show all items

Font sizes vary 
greatly from 
defaults

Reset screen font sizes

Any Any Recordings 
won’t play

CODEC required 
to play calls 
recorded using 
highest 
compression does 
not come with OS 
beginning with 
Windows XP

Download appropriate CODEC from 
the Microsoft web site (L&H Celp) OR 
save call locally. Open with Windows 
Media Player outside active.Web to 
automatically install CODEC if online. 
Otherwise, set channels to lower 
compression.

Any Any with XP 
SP2

Recordings 
won’t play

Known Windows 
XP issue with 
Service Pack 2

Select Tools/Internet Options. On 
Connections tab, click OK. (Not 
necessary to change anything.)
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Vers Hardware Symptom Possible Cause Solution

Any Any Videos won’t 
play
(can’t hear audio 
portion)

Sound is turned off Verify that sound is turned on.

Any Any Error: Sorry, no 
results could be 
found for 
dataservername 
or page cannot 
be displayed  

Host name 
provided was 
incorrect.

Verify that the host name provided was 
correct.  

Any Any Error: Sorry, no 
results could be 
found for 
dataservername 
or page cannot 
be displayed  

Network issues Confirm that you can ping the data 
server machine.  If not, then there are 
possibly network issues if the machine 
is running.

Any Any Error: Sorry, no 
results could be 
found for 
dataservername 
or page cannot 
be displayed  

Web service or 
data server 
machine may be 
down

Confirm that the data server machine 
and web service is running (see Start 
and Stop Services).

Any Any Error: Sorry, no 
results could be 
found for 
dataservername 
or page cannot 
be displayed  

IIS may be corrupt 
and need to be 
reloaded

Check all other possible causes first. Is 
the network up? Are the services 
running? If not other cause can be 
determined, call Technical Support.

Any Any Error: Sorry, no 
results could be 
found for 
dataservername 
or page cannot 
be displayed  

Spyware running 
on data server

Find and remove spyware.
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Vers Hardware Symptom Possible Cause Solution

Any Any Not all icons 
displaying

Use of Windows 
2000 Pro for the 
Web Server only 
allows a limited 
number of 
simultaneous 
clients

Upgrade Data Server to Windows 2000 
Server
NOTE: Version 3.0 and later also 
supports Windows Server2003

Any Any Search won’t 
find known 
recordings OR 
active.Web not 
working right in 
other manner

Spyware running 
on data server

Find and remove spyware.

Any Any Analog 
channels aren’t 
available when 
assigning users 
(or free agents) 

Tap type settings 
incorrect (2487); 
(likely when 
mixing or 
changing 
hardware)

WORKAROUND: Tap Type settings 
likely need changed in database. 
Contact Technical Support.

Any Any active.Web 
locks up

Known issue 
(2641) due to large 
accounts list

Launch active.Web and disable 
Accounts list.

Any Any Error at login: 
Server Create 
Object Access 
Error 
(the call to Server 
Create Object 
failed while 
checking 
permissions). 
Access is denied to 
this object OR The 
page cannot be 
displayed.

File permissions 
changed or are not 
set correctly

In System32 folder, right click one at a 
time on DVUtil.ocx and DV_Client.dll 
folders. Select Properties. At the bottom 
of the Security tab, check the Allow 
Inheritable Permissions box. Click OK. 
Try logging in again. NOTE: It may 
take a few minutes to get a license.
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Vers Hardware Symptom Possible Cause Solution

Any Any Error message: 
Microsoft OLE 
DB 
Provider for 
ODBC Drivers 
error 80004005 
[MySql][ODBC 
3.5.1 Driver] 
[mysqld-4.0.1-
alpha-nt][Got error 
from table handler 
/search/
sub_display.asp, 
line 278

Database table 
may have become 
corrupt

On the database machine, Run DvCon 
and repair tables. Select Leave values 
for db and host at the defaults. Repair 
may take several minutes. Close 
DvCon. 

If this does not resolve the issue, contact 
Technical Support.

Any Any One side of 
recording is 
faint

Gain control 
settings are 
incorrect

Use active.Console to adjust gain 
control.  Refer to active.Console 
documentation for specifics on setting 
parameters.

Any Any Other 
active.Web 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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ALERT ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Alerts continue 

beeping after 
cleared

Known issue WORKAROUND: In active.Console, 
change something in System 
Configuration. Hit OK. Change it back. 
Hit OK. 

Any Any Other alert 
message

Presented in 
message

If possible, resolve issue from 
information presented in message.  
Otherwise, contact Technical Support.

Any Pika T1 PRI Varied (red or 
yellow alarm 
alerts, span goes 
in/out of sync 
randomly

Pika settings for 
Termination Type 
are incorrect in 
Pika Setup

Stop the recording service. (See Start 
and Stop Services) Open Pika Setup to 
the Span Line Settings section. Verify 
Termination Type on every even-
numbered span on each card is set to 
Client and every odd-numbered span is 
set to Network. Save changes. Restart 
the recording service.

Any Any Other alert 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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BEEP TONE ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Parrot 

analog
Beep tone has 
undesirable 
volume or 
frequency

Incorrect beep 
tone setting

In active.Console, go to Beep Tone 
settings. Default volume (-20 Decibels) 
and frequency (15 seconds) means 
every 15 seconds you hear a beep for 
200 milliseconds at a volume of -20 
Decibels. Adjust settings gradually to 
find one that works best.

Any Parrot 
analog

Beep tone not 
working at all

Recorder not 
hooked to line or 
channel turned off

Verify that the channel is turned on, 
recordings are taking place and beep 
tones are enabled for the channel(s).

Any Any other 
than Parrot 
analog

Beep tone not 
working at all

These 
configurations do 
not support beep 
tone at this time

If you require beep tones, external 
devices can be purchased that plug into 
each phone.  Contact Technical Support

Any Parrot 
analog

Beep tone not 
working at all

Beep tone not 
enabled on 
channels

Launch active.Console and enable Beep 
Tones feature.

Any Parrot 
analog

Beep tone not 
working at all

Beep tone not 
enabled on card

Use CyberTech Maintenance Service 
Tool to enable beep tones on card. (see 
Parrot DSC Maintenance Tool)

Any Parrot 
analog

Beep tone not 
working at all

Beep tone not 
supported by card 
OR beep tone not 
licensed on card

Contact Davacord for replacement 
boards.

Any Parrot 
analog

Beep tone 
masks audio in 
recording

Known issue WORKAROUND: Reduce duration of 
beep tone. Contact Davacord for 
replacement boards.

Any Parrot Beep tone masks 
audio in 
recording

Old hardware May need to update hardware.  Contact 
Technical Support.

Any Any Other beep tone 
issues

Check the Release Notes and Known 
Issues list on the DigiVoice Product 
Suite CD.  Contact Technical Support
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CALL DETAIL ISSUES 
Display Text (Caller ID and Digital Phone Display) and Call Direction

Vers Hardware Symptom Possible Cause Solution
Any Pika No Display Text 

Present in 
active.Web

No caller ID 
checks in Pika 
Setup

Go to Start->Programs->Pika 
MonteCarlo->PikaSetup.  On the first 
DSP, add checkmarks in the FSK 
Signaling row on Stream 0 with equal 
number of columns checked on lower 
(0-31) and upper (32-43) sides. Do not 
use columns with other checkmarks. 
The total of upper and lower checks is 
only added on the first DSP on the card. 
Repeat steps on additional Pika 
(Daytona MM) cards. Press the Save 
icon, close PikaSetup and restart the 
Recording Service (see Start and Stop 
Services).  Refer to the hardware 
installation guide for more information.

Any Any analog No Display Text 
Present in 
active.Web

Handset Tap Caller ID is not present on a handset tap.  
No support provided.

Any Any No Display Text 
Present in 
active.Web

Caller ID is not 
provided by your 
switch or by your 
phone company

Check with your telephone service 
provider.

Any Any analog No Display Text 
Present in 
active.Web

Use of Caller ID 
other than North 
American Caller 
ID

No support at this time.

Any Any 
CyberTech 
analog

No Display Text 
Present in 
active.Web

FSK lead-in set 
incorrectly

Run DvCon to edit settings (0,1).

Any Cybertech 
Parrot digital

No Display Text 
Present in 
active.Web

Digital Phone has 
no display.  If a 
digital phone has 
no display, 
typically the PBX 
phone switch will 
not send it any 
display text.

Replace the phone with different model 
that has a display.
18



                                                       
Vers Hardware Symptom Possible Cause Solution

Any Cybertech 
Parrot digital

Display Text is 
incorrect in 
active.Web

PBX sending 
changes to display 
text after 
presenting caller 
information.  Ex: 
Tadiran phone 
switches typically 
send text that 
includes the 
phrases “ON-
HOOK”, 
“NORMAL 
CLEARING”, etc.  
This text may be 
what is stored 
instead of the 
caller information.

Stop all DigiVoice services. On PCI 
digital or TOD systems, wait for DSC 
service to stop.  Run the Parrot DSC 
Maintenance Tool.  Select the affected 
board. At the prompt, type the words 
you want ignored when they appear on 
the display.
Example: exclude 0 “ON-HOOK” 
Example: exclude 1 “CLEARING”

When done, select Settings, change to 
next board if applicable, repeat steps. 
When finished, close all windows and 
restart services.

Any Cybertech 
Parrot

Display Text is 
sporadic or 
incorrect in 
active.Web

PBX phone switch 
or digital phone set 
support issue 

Contact Technical Support. They will 
assist in making log files for analysis or 
provide you with updated firmware if 
required.

Any Pika Unknown call 
direction 

Incorrectly set to 
VOX

Dial tone must be present during 
recording for direction to be determined 
as outbound. Try setting to Loop.

Any Any digital Incorrect call 
direction

Use of ACD, hold 
queues, pages, 
transfers, etc., may 
interfere with 
correct direction 
determination

For most switches this is irresolvable.  
Contact Technical Support

Any Cybertech 
Parrot digital

Incorrect call 
direction

Possible firmware 
issue with switch 
or phone

Contact Technical Support

Any Pika T1/E1 Incorrect call 
direction

Transmit and
receive tap cables
plugged into
wrong ports on
back of card

Switch transmit and receive tap cables 
on back of card

Any Any Other call detail 
issue

Check the Release Notes and Known 
Issues list on the DigiVoice Product 
Suite CD.  Contact Technical Support.
19



                                                       
CONNECTION ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Channels show 

Disconnect
Network 
connection to 
recording server is 
down

To verify, ping the database from 
recording server.  Run cmd and type 
ping hostname (hostname = database 
machine name).  If you get unknown 
host or other error, check network 
settings.  Check Application Event Log 
for any warnings and/or messages.

Any Any Channels show 
Disconnect

Client network 
connection is 
down

Verify client machine is connected to 
network and network is running.

Any Any Channels show 
Disconnect

Recording server 
is down or has lost 
connection to the 
data server

Verify network cables are securely 
fastened and network is operating. 
Verify recording service is running (see 
Start and Stop Services).  If not, reboot 
your recording server. 

Any Any Channels show 
Disconnect

Recording server 
pointed to 
incorrect data 
server

Run DvCon on recording server to edit 
settings. Choose the Recording Servers 
database. Verify database setting 
displayed or correct it. Hit enter to save.  
Restart recording service (see Start and 
Stop Services).

Any Any Channels show 
Disconnect or 
Connected for 
extended period

Multiple IPs for 
same machine

Run ipconfig on recording server to 
ensure it matches database.  Verify only 
one network card is in machine.

Any Any Channels at end 
of recording 
server show 
Connected for 
extended period

Recording server
didn’t start all
channels

Resolve recording service issue.

Any Any (client 
or server 
machines)

Slow to launch 
active.Console or 
active.Monitor

NIC taking too
long to detect
speed of network
automatically

Set to manually detect network speed by 
changing properties of network card. 
Caution: Contact your system 
administrator, as the card speed setting 
must match your network speed. .
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Vers Hardware Symptom Possible Cause Solution

Any Any Other 
connection 
issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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GENERAL ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Forgot admin 

users password
Password needs to 
be reset.

Refer to letter received with system for 
default admin user and password.  
Contact Technical Support.

Any Any Can not log in 
with default 
“admin” 
account

Using Admin 
instead of admin

Refer to letter received with system for 
default admin user and password. Be 
sure not to capitalize the “a” in admin, 
as user name and password are case 
sensitive.  Contact Technical Support.

Any Any Trouble logging 
in, password 
won’t work

Caps lock is on or 
was on when 
password was set

Check to be sure CAPS LOCK key is in 
correct position.  Try logging in using 
all caps or no caps.

Any Any Trouble logging 
in, password 
won’t work

Forgot password Check with your system administrator 
to be sure you are logging in with a 
valid password or ask system 
administrator to reset your password in 
active.Web. 

Any Any Password keeps 
expiring

Password life set 
too short

In active.Web, go to MANAGE/Server 
Options (in some releases, go to 
MANAGE/Options) and increase 
password life.

Any Any (error 
occurs when 
upgrading to 
latest 
version of 
Adobe or 
when trying 
to  launch a 
pdf file on 
any OS 
except 
Win98)

Error message: 
The feature you 
are trying to use 
is on a network 
resource that is 
unavailable.
Click OK to try 
again, or enter an 
alternate path to a 
folder containing 
the installation 
package Microsoft 
Windows Journal 
Viewer.msi in the 
box below

This is an OS issue 
that may arise 
from not having 
the latest updates 
from Microsoft 
prior to installing 
or upgrading 
Adobe Acrobat.

Fix is located on the DigiVoice CD. 
Open the Microsoft folder, the Journal 
Viewer Patch folder, and launch the 
Setup.exe file. (In versions with the 
interactive menu, select Microsoft 
Updates and the Microsoft Journal 
Viewer Patch. Run the Setup.exe file.)

Alternately, download the Journal 
Viewer 1.5 repair from the Microsoft 
web site OR simply use your Control 
Panel to uninstall the Journal Viewer.
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Any Any Sluggish login 
(Console, Web or 
Agent)
OR possibly an 
error generated by 
the recording 
service (i.e., 
Cannot read file. 
Giving up 
transfer.)

Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters section.

Any 
(using 
SDK)

Any Error:
No such interface 
supported

Known issue with
InstallShield

Please refer to: 
http://consumer.installshield.com/
kb.asp?id=Q108521

Any Any Other issues not 
found here

Check the Release Notes and Known 
Issues list on the DigiVoice Product 
Suite CD.  Contact Technical Support
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HARDWARE ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any Amphenol 

cables won’t 
stay on

Incorrect 
amphenol 
connector

Use amphenol bail lock connectors.

Any Any Can’t get 
amphenol bail 
locks attached 
to cable

Cable can’t be 
pushed in far 
enough to 
achieve a secure 
connection

Make sure card is positioned in slot with 
enough clearance between male 
amphenol end and PC chassis. This may 
require opening the box and moving the 
card slightly. Using extreme caution, 
use sharp box knife to trim protective 
shroud on end of cable to allow a more 
snug fit.

Any Any Cable provided 
won’t connect 
to card

Incorrect cable 
sent with system

Contact Technical Support

Any Any Blue screen Intel Accelerator 
not compatible 
with DigiVoice

Go to Start->Programs and look for 
Intel Application Accelerator.  If 
present, go to Control Panel and select 
Add/Remove Programs.  Select the Intel 
Application Accelerator and remove it.  
Reboot your system.

Any (or 
during  
upgrade 
from 
versions 
prior to 
1.0.3)

Pika Card(s) not 
detected in Pika 
setup when 
upgrading the 
Pika drivers

Pika card 
EEPROM needs 
updated

WARNING: This procedure is for 
system administrators only and can 
produce unfavorable results!  Try re-
seating the card first.  Call Technical 
Support first to see if other solutions 
solve the problem.  If not, Update 
EPROM and check to see if cards are 
detected. If not, try a different slot 
and/or check for hardware conflicts. 
If still not detected, contact 
Technical Support.

Any (or 
during  
upgrade 
from 
versions 
prior to 
1.0.3)

Pika DSP won’t show 
up when card is 
re-detected

Card in wrong slot 
and/or hardware 
conflict exists.

Try a different slot.
Check for hardware conflicts.
If neither of these resolve the issue, it is 
possible the card is bad.  Contact 
Technical Support.
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Vers Hardware Symptom Possible Cause Solution

Any Any Card(s) not 
detected or 
listed in Device 
Manager

Cards not seated 
properly

Check to be sure cards are seated 
properly.  Power down and re-seat the 
cards. Power up and try to re-detect 
cards. If Pika cards, see section titled 
Re-detect Pika cards.

Any Any with a 
Parrot card

CyberTech 
cards failed 
after initializing 
in Parrot setup or 
message in 
Application 
Event Log states 
ScanBoardsAnd
BuildStructure 
failed

Known hardware 
issue

Re-boot your system. If this does not 
resolve the issue, increase the 
StartupACKtimeout value in the 
Parrot.ini file in the Cybertech program 
folder to 30000 and reboot.  If this 
doesn’t solve the issue, call Technical 
Support.

Any Any with a 
Parrot card

Unable to load 
or change 
firmware

Known issue Possible to get error or API 
programmer stops loading. 
WORKAROUND: Open the case and 
connect a debug cable (provided by us) 
to the card and to the serial port (COM 
port). Launch the FlashProgrammer 
utility in the CyberTech Drivers folder. 
The utility should then lead you 
through a firmware upload.  ISA 
systems require a different cable. 

Any Cybertech 
Parrot 
Modular 

Drivers won’t 
load correctly

Conflict between 
prior TOD card 
and new modular 
card (very rare)

With the new hardware in place, reload 
the operating system.

Any Any Other driver 
issues

Incorrect driver 
version

Refer to Telephony Driver Release 
Chart table at the end of this document

Any Pika T1 PRI Varied (red or 
yellow alarm 
alerts, span goes 
in/out of sync 
randomly

Pika settings for 
Termination Type 
are incorrect in 
Pika Setup

Stop the recording service. (See Start 
and Stop Services) Open Pika Setup to 
the Span Line Settings section. Verify 
Termination Type on every even-
numbered span on each card is set to 
Client and every odd-numbered span is 
set to Network. Save changes. Restart 
the recording service.

Any Any Other hardware 
issues

Check the Release Notes and Known 
Issues list on the DigiVoice Product 
Suite CD.  Contact Technical Support
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NO LINE ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Cybertech 

Parrot
Channel(s) do 
not properly 
show No Line in 
active.Console, 
but instead 
show Idle or Off
when no phone is 
connected to the 
PBX or phone 
not in service in 
switch

The DigiVoice 
system is tapped to 
wires coming from 
PBX for the 
extension and see 
the PBX as the 
phone

Remove the tap from the PBX.

Any Cybertech 
Parrot

Channel(s) 
periodically 
show No Line in 
active.Console
even though no 
phone is 
connected to the 
PBX or phone 
not in service in 
switch

The DigiVoice 
system is tapped to 
wires coming from 
PBX for the 
extension and 
occasionally 
thinks the signal 
coming from the 
PBX looking for a 
phone is an 
indication the line 
is present

Remove the tap from the PBX.

Any Cybertech 
Parrot 
analog

Channel shows 
No Line

Line voltage 
setting is too high

Change analog line voltage settings in 
CyberTech Maintenance Tool.  (See 
Parrot DSC Maintenance Tool)

Any Cybertech 
Parrot 
analog

Channel shows 
No Line

Handset tap Change analog line voltage settings in 
CyberTech Maintenance Tool to -0-.  
(See Parrot DSC Maintenance Tool)

4.0 or 
greater

Davacord 
VoIP

Channel shows 
No Line

MAC address
not added or has
been removed
via active.Web

Verify that MAC address for the phone 
is still set to record in active.Web
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Vers Hardware Symptom Possible Cause Solution

4.0 or 
greater

Davacord 
VoIP

Channel shows 
No Line
after adding new 
Tap NIC and 
adding MAC 
addresses in 
active.Web

Known issue Reboot system.

Any Cybertech 
Parrot

Channel(s) 
continuously 
show No Line in 
active.Console

No phone 
connected to line

Verify phone is connected to line.

Any Cybertech 
Parrot

Channel(s) 
continuously 
show No Line in 
active.Console

No physical 
connection for that 
line

Use toner to check wiring; correct 
improper or missing wiring.

Any T1/E1 Channel(s) 
continuously 
show No Line in 
active.Console

T1/E1 span is 
down or tap is 
disconnected

Check on span conditions and wiring.

Any Any Channel(s) 
continuously 
show No Line in 
active.Console

Recording Service 
did not start up the 
correct number of 
channels

On Recording Servers, examine the 
Application Event Log to determine if 
the Recording Service started the 
correct number of channels.  If not, refer 
to Hardware and System Installation 
Issues.

4.0 or 
greater

Davacord 
VoIP

All channels for 
individual tap 
NIC show No 
Line

Tap NIC has been
disconnected from
network, disabled
or removed from
system

Under Control Panel->Network 
Connections on the tap NIC’s recording 
server, determine if the tap NIC is 
present and functioning correctly. If not, 
rectify.

Any Cybertech 
Parrot

Channel(s) 
continuously or 
periodically 
show No Line in 
active.Console
(or alternate 
between random 
No Line and 
Idle)

Cable 
disconnected, 
cable loose, or 
bridge clips loose 
or not placed on 
block

Verify that cables are securely fastened 
to card and block. Check all connections 
(including amphenol cable) using toner.  
Make sure bridge clips are securely 
fastened.
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Any Cybertech 
Parrot

Channel(s)  
continuously or 
periodically 
show No Line in 
active.Console 

Bad wiring. Use toner to check wiring; re-punch 
and/or correct improper wiring. Type of 
cable used for the telephone connection 
and are key for correct operation of the 
card. Normally Cat 5 cable or cable of 
equivalent quality is used.  

Any Cybertech 
Parrot or 
Pika T1/E1

Channel(s)  
continuously or 
periodically 
show No Line in 
active.Console

Tap length or 
phone distance 
from switch 
exceeds maximum 
recommended 
distance.  As a 
result, the card 
may no longer 
detect the signals 
correctly.

Shorten tap length or distance of phone 
from switch. For most PBX switches, 
tap should be less than approximately 
60’ (Alcatel 20’) and distance from 
phone to PBX less than 1800’ (Aspect 
450’). With tap distances greater than 
60’, effects partly depend on length of 
cable between PBX and telephone.
Sources of interference close to the 
cable between PBX and telephone or 
close to the tap can interfere with 
correct operation of the card. They can 
substantially reduce the maximum tap 
length that can be used. Refer to the 
System Setup Guide for tap limits for 
your PBX or Contact Technical 
Support.

Any Cybertech 
Parrot

Channel(s)  
continuously or 
periodically 
show No Line in 
active.Console

Line interference Sources of interference close to the 
cable between PBX and telephone or 
close to the tap can interfere with 
correct operation of the card. 
DO NOT run phone wiring parallel 
with electrical.
DO NOT coil your phone line and lay it 
behind your monitor.
DO NOT use a phone jack situated on 
the wall with or right next to a power 
receptacle.
DO NOT run phone lines over 
fluorescent light fixtures in the ceiling.

Any Cybertech 
Parrot

Channel(s) 
continuously or 
periodically 
show No Line in 
active.Console

Unsupported 
digital phone type

Contact Technical Support.
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Any Cybertech 
Parrot

Channel(s) 
continuously 
show No Line 
after re-boot 
until first call 
made

Known issue 
(firmware update 
may resolve)

Contact Technical Support.

Any Cybertech 
Parrot

Channel shows 
No Line after 
unplugging 
phone and 
plugging back in

Known issue for 
Meridian PBX 
(and possibly other 
PBX’s)

WORKAROUND: Pick up handset and 
hung up on channels affected after 
plugging phone back in.

Any Cybertech 
Parrot

Channel(s) on 
individual card 
continuously or 
periodically 
show No Line in 
active.Console

Incorrect PBX 
firmware version 
set in card

Stop Recording Service (see Start and 
Stop Services).  Check firmware using 
technique described in Hardware 
Installation Guide.  If unsure, contact 
Technical Support. 

Any Cybertech 
Parrot

Channel(s) on 
individual card 
continuously or 
periodically 
show No Line in 
active.Console

Bad card Move cable from back of card and place 
on known good card. If problem doesn’t 
move to known good card, then the card 
is probably bad and you should contact 
Technical Support. If problem does 
move, it may indicate a wiring issue. 

Any Cybertech 
Parrot

Channel(s) 
show No Line 
won’t turn off 
or won’t display 
OFF in 
active.Console

By design Resolve No Line issue.

Any Pika T1 PRI Varied (red or 
yellow alarm 
alerts, span goes 
in/out of sync 
randomly

Pika settings for 
Termination Type 
are incorrect in 
Pika Setup

Stop the recording service. (See Start 
and Stop Services) Open Pika Setup to 
the Span Line Settings section. Verify 
Termination Type on every even-
numbered span on each card is set to 
Client and every odd-numbered span is 
set to Network. Save changes. Restart 
the recording service.

Any Any Other no line 
issues

Check the Release Notes and Known 
Issues list on the DigiVoice Product 
Suite CD.  Contact Technical Support.
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RECORDING ISSUES

Vers Hardware Symptom Possible Cause Solution
Any Any No recent 

recordings for 
channel(s) 

Channel turned off Launch active.Console and verify 
channel is turned on.

Any Any No recent 
recordings for 
channel(s) 

Recent Recordings 
criteria too 
restrictive

Reset Recent Recordings criteria and try 
again.

Any Any No recent 
recordings for 
channel(s) and 
active.Console 
shows 
channel(s) 
transitioning 
from Record to 
Idle

Incorrect channel 
settings.  
Minimum 
recording length 
may be too large.

Launch active.Console and adjust 
minimum recording length.

Any Any No recent 
recordings for 
channel(s) and 
active.Console 
shows channels 
transitioning 
from Record to 
Idle

Flex recording or 
other system 
settings are set 
improperly. 

Launch active.Console and adjust 
minimum recording length and/or 
maximum recording length.

Any Multi-box No recent 
recordings for 
channel(s) and 
active.Console 
shows channels 
transitioning 
from Record to 
Idle

Network 
connection issue

Ping the database machine from the 
recording server.  Run cmd and type 
“ping hostname” (without the quotation 
marks and with hostname being your 
database machine name).  If you get 
unknown host or other error, check 
network settings.
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Any Multi-box No recent 
recordings for 
channel(s) and 
active.Console 
shows channel(s) 
transitioning 
from Record to 
Idle

Data server host 
name may have 
changed.

Look for alerts from the recording 
server.  Run DvCon to adjust recording 
server(s) database.  Restart the services. 
(see Start and Stop Services)

Any Multi-box No recent 
recordings for 
channel(s) and 
active.Console 
shows channels 
transitioning 
from Record to 
Idle

Database host 
name may have 
changed.

Look for alerts from the recording 
server.  Run DvCon to adjust recording 
server(s).  Restart the services. (see Start 
and Stop Services)

Any Any No recent 
recordings for 
channel(s) and 
active.Console 
shows channels 
transitioning 
from Record to 
Idle

Database 
recordings table 
may be corrupt.

Database can be corrupted by losses of 
power or other reasons.  Run DvCon to 
repair the database table.

Any Any Recent 
Recordings 
don’t show file 
present for 
quite some time

Network card 
settings

Make sure the network card settings are 
not set to automatic. Specify correct 
network speed in settings.

Any Any Recent 
Recordings don’t 
show file present 
for quite some 
time

Network 
congestion

Place data server and recording servers 
on dedicated switch (recommended: 
100 Mb or 1 Gb).
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Any Any No recent 
recordings for 
channel(s) of 
entire 
Recording 
Server and 
active.Console 
shows 
channel(s) 
transitioning 
from Record to 
Idle

Corrupt queue file Stop the recording service. (See Start 
and Stop Services)  Copy the system32 
folder to another location and rename it. 
Delete all *.queue files in the original 
system32 folder. Restart the recording 
service and see if new calls now show 
up in search results.

Any Any No recent 
recordings for 
channel(s) of 
entire 
Recording 
Server and 
active.Console 
shows 
channel(s) in 
Disconnect state

Recording service 
may be stopped

Verify recording server is started (see 
Start and Stop Services).  If not, start the 
recording service.  If started, close 
Control Panel.  
Click Alt-Ctrl-Del and select Task 
Manager. Select Processes tab. Verify 
DigiVoiceRecordingService.exe is 
listed.  Check Application Event Log to 
verify that the Recording Service started 
up the correct number of channels.  If 
not, refer to Hardware and System 
Installation Issues.

Any Any No recent 
recordings for 
channel(s) of 
entire Recording 
Server and 
active.Console 
shows channel(s) 
in Disconnect 
state

Network issue Ping the recording server.  Run cmd and 
type “ping hostname” (without the 
quotation marks and with hostname 
being your recording server machine 
name).  If you get unknown host or other 
error, check network settings.

Any Any No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Phone not 
connected to 
system.

Verify phone wiring.
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Any Analog No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect channel 
settings.  If 
connected at the 
handset or to 
radio, channel may 
be set to loop

Loop won’t work on a handset 
connection.  Launch active.Console.  
On the Recording Control tab in System 
Configuration, select Vox.

Any Analog No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect channel 
settings. If using 
VOX, threshold 
settings may need 
adjusted

Launch active.Console. On the 
Recording Control tab in System 
Configuration, adjust threshold.  For 
example, if currently set to -52 decibels 
then try changing to -60 decibels.  If 
connected between the switch and the 
phone or on an analog trunk, consider 
changing the channel setting from VOX 
to Loop.

Any Analog No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

If connected at the 
handset or non-
telephony audio 
source, you may 
need amplifiers.

Use a telephone butt set on block to 
verify strong audio is present when 
someone is on the phone.  If it is faint, 
amplifiers are needed.  Contact 
Technical Support.

Any Pika No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

If connected 
between the switch 
and phone AND if 
set to Loop, 
incorrect voltage 
setting specified 
for card.

Verify in Pika Setup that the voltage 
setting is set to whatever is appropriate 
for your line, either -24 or -48. Use a 
voltage meter to determine the 
operating range on the line.

Any Cybertech 
Parrot 
analog

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

If connected 
between the switch 
and phone AND if 
set to Loop, 
incorrect voltage 
setting specified 
for card.

Contact Technical Support for 
instructions on how to use the 
CyberTech Maintenance Tool to view 
and set operating voltages on lines. (see 
Parrot DSC Maintenance Tool)

Any Pika No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Pika board not 
seated properly

Power down and ensure all cards are 
firmly connected.
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Any Pika No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Pika board 
daughter modules 
not seated properly

Power down and ensure all daughter 
modules are firmly connected.

Any Analog No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

If connected 
between the switch 
and phone AND if 
set to Loop, may 
be incorrect loop 
current produced 
by switch (or 
incorrect voltage)

Contact Technical Support.

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Bad wiring. Use toner to check wiring; re-punch 
and/or correct improper wiring. Type of 
cable used for the telephone connection 
and are key for correct operation of the 
card. Normally Cat 5 cable or cable of 
equivalent quality is used.  

4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect MAC 
address entered for 
VoIP phone

Verify MAC address has been correctly 
added in active.Web  

4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

MAC address has 
been assigned to 
the wrong tap NIC

Verify MAC address has been correctly 
associated to its tap NIC in active.Web 

4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect network 
traffic mirroring 
configuration

Confirm network traffic mirroring 
configured correctly in network switch 
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4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Unsupported 
Protocol

Contact technical support

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Line interference Sources of interference close to the 
cable between PBX and telephone or 
close to the tap can interfere with 
correct operation of the card. 
DO NOT run phone wiring parallel 
with electrical.
DO NOT coil your phone line and lay it 
behind your monitor.
DO NOT use a phone jack situated on 
the wall with or right next to a power 
receptacle.
DO NOT run phone lines over 
fluorescent light fixtures in the ceiling.

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Tap length or 
phone distance 
from switch 
exceeds maximum 
recommended 
distance.  As a 
result, the card 
may no longer 
detect the signals 
correctly.

Shorten tap length or distance of phone 
from switch. For most PBX switches, 
tap should be less than approximately 
60’ (Alcatel 20’) and distance from 
phone to PBX less than 1800’ (Aspect 
450’). With tap distances greater than 
60’, effects partly depend on length of 
cable between PBX and telephone.
Sources of interference close to the 
cable between PBX and telephone or 
close to the tap can interfere with 
correct operation of the card. They can 
substantially reduce the maximum tap 
length that can be used. Refer to the 
System Setup Guide for tap limits for 
your PBX or Contact Technical 
Support.
35



                                                       
Vers Hardware Symptom Possible Cause Solution

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect 
recording trigger 
start conditions set 
in card; e.g., use of 
ACD often 
requires setting 
card to use Lamp 
start/stop.

Contact Technical Support.  

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Unsupported 
digital phone type

Contact Technical Support.

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect PBX 
firmware version 
set on card

Stop Recording Service (see Start and 
Stop Services).  Check firmware using 
technique described in Hardware 
Installation Guide.  If unsure, contact 
Technical Support.

Any Cybertech 
Parrot

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Incorrect PBX 
firmware version 
set on card

Check the debug log file located in your 
Program Files folder: 
c:\Program Files\VoiceLogger\
DigiVoice\Debug Logs\
Recording Server.VLVPAPI

Note: Davacord appears instead of 
VoiceLogger in versions 3.0.2 and later

Any Any No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Bad card Contact Technical Support.

Any Any
(+ Nitsuko 
firmware)

No recent 
recordings for 
channel(s) and 
always shows 
Idle in 
active.Console

Set to lampstart 
instead of audio 
start.

Nitsuko firmware defaults to 
lampstart during install or whenever 
card defaults are reset. Disable 
lampstart and enable audio start.
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Any Any No recent 
recordings for 
channel(s) and 
shows Record 
Fail in 
active.Console

Temporary storage 
location full

Verify adequate space left in temporary 
storage location. Run DvCon on 
recording server and edit settings to 
determine storage location. If temporary 
storage is full, verify files are being 
transferred to database machine (in a 
multi-box setting).  Otherwise, make 
room at the temporary storage location.

Any Single box No recent 
recordings for 
channel(s) and 
shows Record 
Fail in 
active.Console

Permanent storage 
location set to non-
existent location

Run DvCon and edit settings to verify 
or change permanent storage location 
setting.

Any Multi-box No recent 
recordings for 
channel(s) and 
shows Record 
Fail in 
active.Console

Temporary storage 
location set to non-
existent location

Run DvCon on recording server and 
edit settings. Choose option to verify or 
change temporary storage location 
setting.

Any Single box No recent 
recordings for 
channel(s) and 
shows Record 
Fail in 
active.Console

Storage location is 
full

Back up old recordings and delete them 
to make room for new recordings.

Any Any No recent 
recordings for 
channel(s) and 
shows Record 
Fail in 
active.Console

Bad card Contact Technical Support.

Any Multi-box Recent 
recordings for 
channel(s) but 
icons are 
dimmed for all 
recordings

Data service is 
stopped

Verify that the data service is running 
(see Start and Stop Services).Run 
DvCon
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Any Multi-box Recent 
recordings for 
channel(s) but 
icons are 
dimmed for all 
recordings

Data service 
storage capacity is 
full

Check storage space on data server.

Any Any Recent 
recordings for 
channel(s) but 
icons are 
dimmed for all 
recordings

Virtual directory 
not set correctly in 
IIS.  

Verify virtual directory is set to 
permanent storage location.

Any Multi-box Recent 
recordings for 
channel(s) but 
icons are 
dimmed for all 
recordings

Permanent storage 
location changed 
to incorrect 
location or virtual 
directory was not 
updated correctly 
when change was 
made.

Use active.Console to confirm 
permanent storage location is correct.  
Verify virtual directory is set to 
permanent storage location.

4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
channel(s) and 
active.Console 
flashes Record 
briefly at the 
beginning of the 
call

Unsupported audio 
codec

Examine application event log on 
recording servers for errors indicating 
unsupported codecs.  If any exist, 
change the codec type in your PBX 
configuration.

4.0 or 
greater

Davacord 
VoIP

No recent 
recordings for 
all channels of a 
tap NIC and 
always shows 
Idle in 
active.Console

Tap NIC plugged 
into incorrect port 
on switch

Move tap NIC network cable to correct 
switch mirroring port

4.0 or 
greater

Davacord 
VoIP

Only one side of 
conversation 
recorded

Spanning has been 
setup incorrectly 
in the switch 

Correct switch spanning settings
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4.0 or 
greater

Davacord 
VoIP

Garbled audio Spanning has been 
setup incorrectly 
in the switch 
causing audio 
packets to be seen 
more than once

Correct switch spanning settings

4.0 or 
greater

Davacord 
VoIP

Garbled audio Network 
congestion 
slowing receipt of 
audio

Increase jitter buffer in active.Console 
under the Quality tab of System 
Configuration or increase network 
capacity

Any CyberTech 
digital
(NEC or 
Aspire 
switch 
only)

Recordings cut 
off or not being 
made due to 
card rebooting

Possible known
issue with NEC or
Aspire firmware

Contact Technical Support.

Any Any Able to locate  
older specific 
recording in 
search, but icon 
is dimmed

Recording may 
have been purged 
from the system to 
make space

Restore recording from backup.

Any Any Able to locate  
older specific 
recording in 
search, but icon 
is dimmed

Permanent storage 
location changed.

Move old files or folders to new 
location.

Any Any Clicking noise 
or static in 
recording

Faulty wiring Re-punch channel where recording was 
made. If this doesn’t resolve problem 
AND the phones are same type as others 
recording without a clicking noise, 
move a known good line to one with the 
clicking issue by re-punching them at 
the block to verify the card is good.
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Any Any Clicking noise or 
static in 
recording

Line interference Sources of interference close to the 
cable between PBX and telephone or 
close to the tap can interfere with 
correct operation of the card. 
DO NOT run phone wiring parallel 
with electrical.
DO NOT coil your phone line and lay it 
behind your monitor.
DO NOT use a phone jack situated on 
the wall with or right next to a power 
receptacle.
DO NOT run phone lines over 
fluorescent light fixtures in the ceiling.

Any Any Clicking noise 
in recording

Line issues to CO Contact your telephone company.

Any Analog 
modular

Clicking on line Known CyberTech
issue: message
waiting indicator
blinking on any
phone can cause
clicking noise

Change to a Pika card or disable that 
feature on your phone if possible

Any Pika T1/E1 
and 
Cybertech 
Parrot

Extremely poor 
audio quality on 
digital channels

Incorrect settings 
for Primary Master 
or Slave

Check appropriate hardware installation 
guide from the DigiVoice CD and verify 
your settings are correct.

Any Pika Hum in 
recordings
but not in audio 
during call

Grounding issue Ground recording server power supply.  
Contact Technical Support for 
additional details

Any Pika Hum in 
recordings but 
not in audio 
during call

Loose
connection(s)

Re-seat card(s). Check screws at all 
connections to ensure adequate contact 
is made.

Any Analog Cross talk 
heard in phone

Faulty wiring or 
bad card.

Detach cables from system.  If symptom 
remains, problem is wiring.
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Any Pika Cross talk 
heard in 
recordings on 
channels not 
supposed to be 
tapped, but not 
heard in phones

Channel detached 
from phone line on 
Vox and not turned 
off.

Turn off channels not attached to phone 
lines.

Any Analog Echo on lines Poor telephone 
connection 
unrelated to 
DigiVoice system.

Contact your local telephone service 
provider.

Any Any One or more 
sides of 
conversation 
very faint

Gain control 
settings are 
incorrect.

Use active.Console to adjust gain 
control.  Refer to active.Console 
documentation for specifics on setting 
parameters.

Any Analog One or more 
sides of 
conversation 
very faint

Handset 
connection taps 
may require 
amplifiers

Use butt set at block on line to see if 
audio is loud enough.   If not, you may 
need amplifiers.  Call Technical 
Support.

Any
after 
upgrade 
from 
older 
version

Parrot 
modular 
analog 

One or more 
sides of 
conversation 
very faint

AGC settings not 
available for this 
hardware before 
3.0.2

After upgrade, adjust AGC settings.

Any Any No audio in 
recording

Cables not secure 
or cable is bad

Verify cable is connected securely. If 
this does not resolve issue or if cable is 
not present, contact Technical Support.

Any Any No audio in 
recording

Sound card may 
not be functioning

Confirm sound card is working 
correctly. (NOTE: For Windows 
Server2003, check that Windows Audio 
is enabled)

Any Windows 
Server2003

No audio in 
recording

Sound card may 
not be functioning

Check that Windows Audio is enabled.

Any Pika Parrot 
ISA or PCI

No audio in 
recording

Pika master bus 
settings incorrect

Confirm settings are correct as 
described in the Hardware Installation 
guide on your DigiVoice Product Suite 
CD.
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Any Cybertech 
Parrot

No audio in 
recording

Incorrect firmware 
or Parrot card for 
switch

Refer to the Hardware Installation guide 
on your DigiVoice Product Suite CD.

Any Cybertech 
Parrot

No audio in 
recording

Unsupported 
phone type for 
firmware

Contact Technical Support.

Any Pika (and 
during an 
upgrade) 
using Monte 
Carlo 5.6 or 
later

No audio in 
recording

EEPROM needs 
updated

WARNING: This procedure is for 
system administrators only and can 
produce unfavorable results!  Try re-
seating the card first.  Call Technical 
Support first to see if other solutions 
solve the problem.  If not, Update 
EPROM and check to see if cards are 
detected.

Any Any using 
Windows 
Terminal 
Server

No audio in 
recording

Special settings 
required on server 
and client machine 
in a WTS 
environment

See the Windows Terminal Server 
section in System Setup Guide

Any Analog Missing first 
seconds
of conversation 
or radio traffic

Weak signal Procedure only recommended if the 
symptom occurs frequently. Change 
thresholds for VOX detection or use 
powered amplifier.

Any Parrot 
analog OR at 
least one 
Pika card 
(set to VOX)

Missing first 
seconds
of conversation 
or radio traffic

VOX lead-in time 
needs adjusted

Use active.Console to adjust lead-in 
time.

Any Any Recording of 
single call 
broken up into 
multiple files

Use of VOX mode 
with Incorrect 
threshold and/or 
stop delay settings

If possible, use Loop/Switch activated 
(non-handset). Procedure only 
recommended if the symptom occurs 
frequently.   If VOX is required, launch 
active.Console and adjust threshold 
and stop delay until you find a 
reasonable solution.  Apply to all or 
only selected channels.  Click OK. 
NOTE: Long stop delays may cause 
two recordings to be tied together.  We 
recommend a default threshold setting 
of -52 decibels and a 5 seconds stop 
delay.
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Any Cybertech 
Parrot digital

Recording of 
single call 
broken up into 
multiple files

Use of 
Speakerphone 
with some Lucent 
4-wire switches 
only recording one 
side in Direct 
Audio mode

Stop recording service (see Start and 
Stop Services) and launch the Parrot 
DSC Maintenance Tool. Click OK for 
Board 1. Type vox_setup 1 50 5000 and 
hit enter. Choose Settings->Board to 
select next board. Repeat steps for each 
board. Close applications and restart 
service (see Start and Stop Services).

Any Cybertech 
Parrot digital

Recording of 
single call 
broken up into 
multiple files

Using VOX and 
parameter for one-
sided and two-
sided trigger is 
incorrect

Most switches should be set to one-
sided trigger. Run DvCon and edit 
settings to change. (NOTE: Alcatel and 
Ericsson should be two-sided)

Any Cybertech 
Parrot digital

Recordings 
made when no 
one is on phone

Use of VOX and 
parameter for one-
sided and two-
sided trigger is 
incorrect

Most switches should be set to one-
sided trigger but Alcatel and Ericsson 
should be two-sided. Run DvCon and 
edit settings to change.

Any Any Record on 
demand or 
client start/stop 
using hot keys 
won’t work
but previously 
did

Possible conflict 
with other 
programs 

Try using different keys.

Any Any Record on 
demand or 
client start/stop 
using hot keys 
never has 
worked

Possible conflict 
with other 
programs 

Try using different keys. If no keys 
work, call Technical Support for 
instructions on using our tool to very 
compatibility.
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Any Any Two calls put 
together into a 
single recording

Use of VOX mode 
with Stop delay 
value set too high

Procedure only recommended if the 
symptom occurs frequently. Launch 
active.Console and adjust Stop Delay.  
Stop Delay value indicates how many 
seconds of silence the system detects 
before it stops recording.  For example, 
if Stop Delay is set to 30 (seconds) and 
you only experience 15 seconds of 
silence between recordings, the system 
ties the two recordings together because 
it didn't detect at least 30 seconds of 
silence.  Lower Stop Delay (number of 
seconds of silence) to five (5). 

Any Parrot digital Two calls put 
together into a 
single recording

Incorrect start stop 
settings

Use Parrot DSC Maintenance Tool to 
change settings

Any Any Channel shows 
Record Limit in 
active.Console

Valid message: not 
enough  licenses 
for another 
concurrent 
recording OR 
recording license 
has expired

Contact one of our sales agents or 
Technical Support.

Any Cybertech 
Parrot

Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Misinterpreted 
switch signal 
because of 
interference on 
line; may be faulty 
wiring.

Turn channel off, then on.  Pick up and 
hang up phone.  If problem persists, 
punch down channel again and verify 
there is no EMF interference on line. If 
channel still stuck on or continues to get 
stuck on repeatedly, contact Technical 
Support.

Any Cybertech 
Parrot

Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Unsupported 
phone type

Contact Technical Support.
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Any Any Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Using client 
device start/stop 
and didn’t use stop 
key

Be sure to use stop key when configured 
for client device start/stop

Any Pika Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Line not connected 
to system (Loop)

Use toner to check wiring; correct 
improper or missing wiring.  Ensure 
cable is plugged in to back of card. Turn 
off channels not in use.

Any Analog Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Incorrect threshold 
settings in VOX 
combined with 
small amounts of 
static on line

Turn channel off, then on.  If problem 
persists, punch down the channel again.  
If still stuck on, listen for line noise with 
a butt set. If there is noise when set to 
VOX, launch active.Console and reduce 
the threshold settings.  If this does not 
resolve the problem or if there is no line 
noise heard with butt set, contact 
Technical Support.

Any Analog Channel 
continues to 
show Record in 
active.Console, 
yet no one is on 
the line

Possibly beep tone 
and VOX setting 
forcing the system 
to continue 
recording

Adjust stop delay in active.Console to 
less than the beep tone frequency.

Any Any Unable to locate 
a specific 
recording

Search criteria 
incorrect or too 
narrow

Verify search criteria; relax search 
criteria (search  broader time range, 
etc.).

Any Any Unable to locate 
a specific 
recording

User's clock set 
incorrectly

Calls are stamped according to 
recording server time, which syncs to 
the data server.  Verify PC clock on 
client is set to the same time as the 
recording server.

Any Any Unable to locate 
a specific 
recording

If delete option is 
available, call may 
have been deleted 

Check to see if recording can be 
restored from the backup media.
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Any Any Unable to locate 
a specific 
recording

Recording may 
have been purged

Check logs. If recording was purged, try 
restoring from backup.

Any Any Unable to locate 
a specific 
recording

Call may not have 
been recorded due 
to recording 
restrictions and/or 
requirements

Check restrictions and requirements in 
active.Console to ensure all future 
calls you want recorded are being 
recorded. 

Any Any Some recordings 
never appear
OR take a long 
time to appear in 
database (>5 
minutes). May be 
accompanied by 
occasional error, 
such as: Cannot 
read file. Giving 
up transfer. 

Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters section.

Any Any Incorrect or no 
user associated 
with recording

User is not 
assigned to the 
correct channel

Use active.Web to verify the user is 
assigned to the correct user.

Any Any Incorrect or no 
user associated 
with recording

Labeling of 
channels is 
incorrect or line 
cabling was 
misidentified 
when installed.

Correct labeling and verify line 
connections are correct.

Any Any Incorrect or no 
user associated 
with recording

Free agent user did 
not logout/login to 
active.Agent.

Use forced login.

Any Any Incorrect or no 
user associated 
with recording

Free agent seating 
not set up correctly 
on active.Agent 
client machine.

Launch active.Agent on the client 
machine and verify the settings.

Any Any Incorrect or no 
user associated 
with recording

Used ghost 
machine to copy 
client software and 
master ghost 
machine not 
configured 
properly

See ghost procedures on DigiVoice CD.
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Any Any Recordings not 
found or not 
stored in correct 
location

File storage tab no
longer removes
leading back-
slashes in  storage
path field. (2401)

Launch active.Console. On the Data 
Server Actions tab, remove any leading 
backslashes.

Any Digital PCI 
or T1 CAS
(with DTMF 
enabled)

First call 
doesn't capture 
DTMF 
after recording 
service started or 
recording server 
rebooted

Known issue with
card

WORKAROUND: Any time recording 
service is restarted or recording server is 
rebooted, use maintenance tool to 
manually start and stop all channels. 
Select a board, then type ch_start all 
and hit enter. After a few seconds, type 
ch_stop all. Select each board and 
repeat process.

Any Any Other recording 
issue

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support
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SCREEN CAPTURE ISSUES
The issues in this section pertain ONLY to systems with screen capture.

Vers Hardware Symptom Possible Cause Solution
Any Any Screen capture 

stops before 
recording is 
finished

Conflict between 
wrap-up time and 
screen capture flex 
recording settings

Example: if channel set to full-time 
screen capture (active.Console) and 60 
seconds of wrap-up time (active.Agent) 
and a new call begins during wrap-up, 
screen capture stops for completed call 
and STARTS for new call. 

Any Any Screen capture 
stops before 
recording is 
finished

Screen resolution 
changed during 
recording

Changing screen resolution during a 
recording aborts the capture.   

Any Any Screen capture 
licenses 
exceeded
while not enough 
simultaneous 
recordings to 
exceed license

Known issue 
(#3305)

Advise users without administrative 
rights on a machine NOT to repeatedly 
attempt to enable/disable screen 
capture.

Any Any Unable to email 
screen capture 
videos with 
audio

By design It is not possible to email the video 
portion of recordings that were 
captured.  Only the audio is sent. 

Any Any Videos won’t 
play
(can’t hear audio 
portion)

Sound is turned off Verify that sound is turned on.

Any Any with 
WindowsXP

Error when 
installing screen 
capture driver

Microsoft Firewall 
(installed with 
SP2) won’t allow 
screen capture 
driver to install

Launch the active.Agent User’s Guide 
and follow the Screen Driver 
Installation instructions specific to 
Windows XP with SP2.

Any Any Playback of AVI 
files in 
active.Web off 
significantly

Using Media 
Player 6.0 
(especially if 
frame rate is 1 
every 5 seconds 
(#2376)

Upgrade to Media Player 8 or better OR 
save the file locally and play it that way 
(Media Player 6.0 works fine when not 
playing the AVI in active.Web).
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Any Any Videos take 
significant  time 
to show up in 
active.Web

NIC settings 
incorrect

Adjust advanced settings for network 
speed. Change from “auto detect” to 
speed of network.

Any Any Videos take 
significant  time 
to show up in 
active.Web

Network 
congestion

Place data server and recording servers 
on dedicated switch (recommended: 
100 Mb or 1 Gb).

Any Any Videos never 
show up in 
active.Web

Video service 
stopped

Start video service. (see Start and Stop 
Services

Any Any Videos never 
show up in 
active.Web

Video service 
crashed

Contact Technical Support

Any Any Videos never 
show up in 
active.Web

Network issues Resolve network issues. 

Any Any Videos never 
show up in 
active.Web

Data server name 
changed

Run DvCon to set new name.

Any Any Videos never 
show up in 
active.Web

Screen capture 
feature not enabled 
on client machine

Enable screen capture.

Any Any Videos never 
show up in 
active.Web

Clients not in use Verify active.Agent is launched and user 
(or free agent) is logged in.

Any Any Videos never 
show up in 
active.Web

Not enough video 
licenses

Contact Technical Support or a sales 
agent if you need to purchase additional 
screen capture licenses.

Any Any Videos never 
show up in 
active.Web

Random settings 
incorrect in 
active.Console for 
video

Ensure correct setting in active.Console 
for screen capture (random, full-time, 
off).

Any Any Videos never 
show up in 
active.Web

Data server drive 
full

Check storage capacity on data server.
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Any Any Videos never 
show up in 
active.Web

Known issue 
(#2822)

Advise users: if more than one user is 
logged into XP through fast user 
switching, only the user actively using 
the operating system is screen captured, 
even though active.Console reflects all 
users being screen captured. 

Any Any Videos never 
show up in 
active.Web

Encyrption is set Screen capture will not work properly if 
encryption is set. Disable encryption for 
channel(s) where you want to capture 
video.

Any Any Screen capture 
failure shows in 
active.Console

No video server(s) 
present

Verify video service is running and 
connected to network.

Any Any Screen capture 
failure shows in 
active.Console

Video server(s) 
busy

Try one or more of the following:
Reduce frame rate on client machine.
Use random vs. full-time recording.
Reduce screen size of client PCs.
Use grayscale vs. color.
Add more video servers if necessary.

Any Any Screen capture 
failure shows in 
active.Console

Network issues on 
video server(s)

Resolve network issues.

Any Any Screen capture 
failure shows in 
active.Console

Video server drive 
failure or full

Increase drive capacity  
Resolve any network issues between 
video server and data server.
If drive is bad, replace it.

Any Any Screen capture 
failure shows in 
active.Console

Video server has 
crashed

Contact Technical Support.

Any Any Screen capture 
failure shows in 
active.Console

Network issues on 
client machine

Resolve network issues.

Any Any Screen capture 
failure shows in 
active.Console

Not enough video 
licenses

Contact Technical Support or a sales 
agent if you need to purchase additional 
screen capture licenses.

Any Any Screen capture 
failure shows in 
active.Console

CODEC not 
present on video 
service

Install CODEC on video server.
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Any Any Screen capture 
failure shows in 
active.Console

Mirror driver set 
up incorrectly on 
client machine

Uninstall and reinstall mirror driver.

Any Any Screen capture 
icon does not 
appear in 
active.Console

By design (if you 
are viewing 
channels) 

Switch to user view instead of channel 
view.

Any Any Other screen 
capture issues

Check Release Notes and Known Issues 
list on the DigiVoice Product Suite CD.  
Contact Technical Support.
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SERVICE ERRORS

Vers Hardware Symptom Possible Cause Solution
Any Pika Parrot 

PCI
Error message:
DigiVoiceRecord
ingServer.exe 
has generated an 
error and will be 
shut down and an 
error log created

Incorrect Parrot 
PCI driver

In Device Manager->Digital Speech 
Converters->Parrot DSC PCI, right 
click and select Properties. On the 
Drivers tab, select Driver Details. Verify 
version is 0.10.0.0.  If not, use 
CyberTech version 1.5 to upgrade 
drivers.  Re-verify file version.  (Default 
properties version will state 0.9.2.0, but 
Driver Details reflects correct version 
0.10.0.0.). 
NOTE: Correct version subject to 
change with new DigiVoice software 
releases.  Refer to Telephony Driver 
Release Chart at the end of this 
document.

Any Parrot Recording 
service goes to 
99% CPU

Hyperthreading 
disabled on server 
running SP 4

If a server is hyper-threading
capable, make sure it is turned on.
Service Pack 4 (SP4) must be used
on hyperthreaded or dual processor
machines. In all other cases, Service
Pack 3 (SP3) must be used. 

Any Parrot Recording 
service goes to 
99% CPU

Non-hyperthread 
machine running 
Service Pack 4.

If server is not hyper-threading capable, 
Service Pack 3 (SP3) must be used. To 
‘downgrade’ from SP3 to SP4, stop 
recording service (see Start and Stop 
Services). Select Start-Programs-
CyberTech-Parrot DSC from the 
desktop. Click Uninstall. Remove SP4 
drivers. On the DigiVoiceXE CD, select 
Telephony Drivers->Parrot Modular. 
Open SP3 folder and run Setup Parrot 
DSC API 1.0 Including SP3.exe. From 
SP3 folder on CD, open the Drivers 
folder. Copy PrtPCI.sys. Navigate to 
C:\Windows\system32\ drivers (or 
C:\WINNT\system32\drivers on 
Windows 2000). Paste the copied file to 
this location. Restart recording service.
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Any Any Application 
Event Log 
Warning or 
Error Message

Presented in 
message

If possible, resolve issue from 
information presented in message.  
Otherwise, contact Technical Support.

Any Any 
CyberTech 
(with SP4)

DSC Service 
never stops on 
CyberTech SP4

Known issue 
(#3122)

On some systems, it may be possible to 
end the process through Task Manager. 
If not, use the procedure below.

WORKAROUND: Navigate to 
C:\Program Files\CyberTech\Parrot 
DSC.  Open the Parrot.ini file. Locate 
the line "autoclose=0" and change the 0 
to a 1. Save the change to the file.  
Restart the recording service

Any Any New recording 
server does not 
show in servers 
page

Recording server 
not connected and/
or not detected

Re-boot your recording server.  If 
recording server is still not shown, try 
one of the other solutions listed below.

Any Any New recording 
server does not 
show in servers 
page

Recording service 
machine not on 
network

Ping database machine from recording 
server. Run cmd. Type ping hostname  
(hostname = your database machine 
name). If you get unknown host or other 
error, check network settings.

Any Any New recording 
server does not 
show in servers 
page

Recording service 
database host 
name set wrong

Run DvCon on recording server. In the 
edit settings area, verify recording 
service database name. Change if 
incorrect.  Hit enter to save

Any Any Recording 
Service starts 0 
Channels

Card setup issue Examine the Application Event Log for 
possible explanation of issue and take 
corrective action.  Contact Technical 
Support if the problem can not be 
resolved.

Any Any Recording 
Service starts 0 
Channels

Card in bad state Power down recording server. Unplug 
power cable for five minutes. Plug back 
in and start system.

Any Any Recording 
Service starts 0 
Channels

Bad card Contact Technical Support.
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Vers Hardware Symptom Possible Cause Solution

Any Any Recording 
Service starts 0 
Channels

Known issue: 
recording service 
attempts to start 
before driver is 
running

WORKAROUND: This workaround 
requires registry setting change. Open a 
command prompt on recording server. 
Run regedt32 on recording server. Click 
HKEY_LOCAL_MACHINE. Open 
System->CurrentControlSet->Services-
> DigiVoice Recording Service. Select 
Edit->Add Value from menu bar. Type 
DependOnService (no spaces) for 
value name. Data type is 
REG_MULTI-SZ. Click OK. For 
multi-string editor, type:
ParrotDSC [return], PrtPCI [return], 
PikaDaytona [return], PikaDsp [return], 
PikaPrimeNet [return], mtpci [return], 
NVDSP [return]. Click OK. Reboot the 
recording server.

Any Any Recording 
service crashed 
for unknown 
reason

Unknown Reboot machine. Check log file for 
messages. Send log files to Technical 
Support.

Any Any Error message
such as: Cannot 
read file. Giving 
up transfer.

Insufficient RAM
on data server. To
verify this, find the
recordings.myi
file on data server.
If file size is 70%
of total RAM or
more, this may be
the problem.

Set to purge regularly. Otherwise, add 
more RAM to the data server and/or 
review the MySQL Parameters 
dsection.

Any Any Data service not 
receiving license 
from recording 
service
in active.Console

Norton Internet
Security may be
enabled, blocking
traffic 

If listening sockets are available but no 
connection can be established, disable 
Norton Internet Security OR configure 
it to allow communications wit our 
ports (3410, 3400, 3420, 3306)

Any Any Can’t connect to
one or more
services 
in active.Console

Norton Internet
Security may be
enabled, blocking
traffic 

If listening sockets are available but no 
connection can be established, disable 
Norton Internet Security OR configure 
it to allow communications wit our 
ports (3410, 3400, 3420, 3306)
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Vers Hardware Symptom Possible Cause Solution

Any Davacord 
VoIP

Wrong recording
server IP
address; trouble
connecting to or
staying connected
to clients

More than one
NIC card in use
and wrong card is
coming up first in
the system

Stop the recording service.  (See Start 
and Stop Services) Select Start/Settings/
Control Panel/Network and Dialup 
Connections. Select Advanced, then 
select Advanced Settings. On the 
Adapters and Bindings tab, the multiple 
NICs are shown. Select the NIC to be 
used and click the UP arrow until it is 
the first one shown. Click OK and 
restart the recording service.

Any Any Other service 
error messages

Check the Release Notes and Known 
Issues list on the DigiVoice CD. Contact 
Technical Support.
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UPGRADE ISSUES

Vers Hardware Symptom Possible Cause Solution

Any (or 
during  
upgrade 
from 
versions 
prior to 
1.0.3)

Pika DSP won’t show 
up when card is 
re-detected

Card in wrong slot 
and/or hardware 
conflict exists

Try a different slot.
Check for hardware conflicts.
If neither of these resolve the issue, it is 
possible the card is bad.  Contact 
Technical Support.

Any Pika (and 
during an 
upgrade) 
using Monte 
Carlo 5.6 or 
later

No audio in 
recording

EEPROM needs 
updated

WARNING: This procedure is for 
system administrators only and can 
produce unfavorable results!  Try re-
seating the card first.  Call Technical 
Support first to see if other solutions 
solve the problem.  If not, Update 
EPROM and check to see if cards are 
detected.

Any (or 
during  
upgrade 
from 
versions 
prior to 
1.0.3)

Pika Card(s) not 
detected in Pika 
setup when 
upgrading the 
Pika drivers

Pika card 
EEPROM needs 
updated

WARNING: This procedure is for 
system administrators only and can 
produce unfavorable results!  Try re-
seating the card first. Call Technical 
Support to see if other solutions solve 
the problem.  If not, Update EPROM 
and check to see if cards are detected. If 
not, try a different slot and/or check for 
hardware conflicts. If still not detected, 
contact Technical Support.

Any
(after 
upgrade 
from 
versions 
prior to 
3.0.2)

Parrot 
modular 
analog

One or more 
sides of 
conversation very 
faint

AGC settings not 
available for this 
hardware in 
versions prior to 
3.0.2

After upgrade, adjust AGC settings in 
active.Console.

Any
(after 
rec. 
service 
upgrade)

Parrot Varies according 
to switch

Not running 
latest firmware 
version

Verify whether firmware is the latest 
version on the release CD. If not, update 
the firmware. Before doing so, write 
down any custom settings. (If Davacord 
configured custom settings for you, call 
Technical Support.)

Any Any Other upgrade 
issues

Check the Release Notes and Known 
Issues list on the DigiVoice CD. Contact 
Technical Support.
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COMMON TASKS
This section describes tasks referred to in this document.  If you have questions or concerns about
performing these functions, contact Technical support.

Re-detect Pika cards
From your desktop, select Start->Programs->PIKA->MonteCarlo 6.1 and launch the PIKA Setup
program. Once the program starts, click the magnifying glass icon to detect the boards.  When
asked if you're sure you want to re-detect the boards, click Yes. 

Run DvCon
DvCon is a utility created to help troubleshoot issues and perform certain operations when
working with the DigiVoice software. A DvCon User’s Guide, located in the Documentation
folder on the DigiVoice Software Suite CD, explains the commands required to perform functions
within the utility. 

To launch DvCon from the desktop, selecting Start->Run. and type dvcon if you are running the
utility on a system where the services are installed. At the command prompt, type the command as
it is listed in the Command column (refer to the DvCon User’s Guide). Some commands are
password protected to prevent untrained personnel from conducting tasks that could have
undesirable results. There is a help dialogue in DvCon.

Parrot DSC Maintenance Tool
METHOD A: Stop the recording service according to instructions below. From your desktop,
select Start->Programs->CyberTech->Parrot DSC->Parrot DSC API Demo. When the window
opens, click Initialize, then Execute, then Init System. Leave the AP Demo window open, and
launch the Parrot DSC Maintenance Tool. Follow the instructions given in the Troubleshooting
Guide for your particular issue.  

METHOD B: Call Technical Support for an automated maintenance tool that can be used while
the recording service is running.

Start and Stop Services
From your desktop, select Start->Settings->Control Panel->Administrative Tools->Services. Find
the service you wish to stop or start (i.e., DigiVoice Data Service, DigiVoice Recording Service).
Right-click and select Start (or Stop) to perform the operation.  Repeat these steps to perform the
opposite function.
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Update EPROM
From your desktop, select Start->Programs->PIKA MonteCarlo 6.1->UpdateAllProms (some
versions may say Update EEPROM). When the UpdateAllProms box opens, press any key to
continue.  Do not be alarmed to see system error messages in the box while your drivers are being
updated.  When the procedure is finished, press any key to reboot your system.
IMPORTANT! Updating EEPROM is a procedure meant to be performed one time only.  If
you later update drivers on your system, do NOT run EEPROM again.

Application Event Log
To view the event log, right-click on My Computer and select Manage. Click the + sign to expand
the Event Viewer menu.  Select Application log. On the right side of the screen is an application
event log where you will find events pertaining to DigiVoice software.  Double-click on any event
(shown on the right) to see details.

MySQL Parameters
In some circumstances, you may choose to change certain settings to maximize data server
performance. 

Optimizing key_buffer_size
Stop the MySQL service and locate the my.ini file. You should see a line similar to the following:
key_buffer_size=256M.

The maximum practical value of the key_buffer_size parameter ranges from 1/4 to 1/2 of the
amount of system memory, depending on how much memory is used by other applications. Set
the key_buffer_size equal to 1/4 of the system memory on single-box systems.  Set the
key_buffer_size to 1/2 of the system memory on a data server with no recording service present.
For example, 256MB is appropriate for a 1GB single-box configuration or 512MB for a multi-box
configuration.

After making the adjustments, restart the MySQL service.

WARNING! Do NOT change any other settings in this file!  If you have
any questions about this setting, please contact Davacord Technical
Support.
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Telephony Driver Release Chart

This chart contains telephony driver information for all versions of DigiVoiceXE software.

Hardware Type Software Version Driver Version

Ai-Logix ISA

1.0.1 – 1.0.2 Not supported
1.0.2.1 – 1.0.3.3 5.3.0
1.0.4 – 1.0.4.1 Not supported
1.1 – 2.0.2.7 5.3.0
2.1 – 2.1.0.1 Not supported
2.1.0.3 – 2.1.0.x 5.3.0
3.0 and up Not supported

Ai-Logix PCI

1.0.1 – 1.0.1.1 2.2.0.1
1.0.2 Not supported
1.0.2.1 – 1.0.3.3 2.2.0.1
1.0.4 – 1.0.4.1 Not supported
1.1 – 2.0.2.7 2.2.0.1
2.1 – 2.1.0.1 Not supported
2.1.0.3 – 2.1.0.x 2.2.0.1
3.0 and up Not supported

Pika (Analog)

1.0.1 - 1.0.1.1 5.6.2.28
1.0.2 5.7.1.95
1.0.2.1 Not supported
1.0.3 - 1.0.3.3 5.7.1.95
1.0.4 - 1.0.4.1 Not supported
1.1 - 1.1.3 5.7.1.95
1.2 - 2.0 6.0.0.94
2.0.1 - 2.0.2.7 6.1.0.118
2.1 – 2.1.0.1 Not supported
2.1.0.3 – current 6.1.1.131

Pika (T1-E1)

1.0.1 - 1.0.3.3 Not supported
1.0.4 - 1.0.4.1 6.0.0.94
1.1 - 1.1.3 Not supported
1.2 - 2.0 6.0.0.94
2.0.1 - 2.0.2.7 6.1.0.118
2.1 – 2.1.0.1 Not supported
2.1.0.3 – current 6.1.1.131

Pika / Parrot ISA

1.0.1 - 1.0.1.1 1.0.0.1
1.0.2 - 1.0.2.1 Not supported
1.0.3 - 1.0.3.3 1.0.0.1
1.0.4 - 1.0.4.1 Not supported
1.1 - 2.0.2.7 1.0.0.1
2.1 – 2.1.0.1 Not supported
2.1.0.3 – current 1.0.0.1
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* - 1.0.10.0 is backwards compatible back to version 3.0.3.

 - If the server machine is hyperthreading capable, make sure it is turned on. Service Pack 4 (SP4) must
be used on hyperthreaded or dual processor machines. In all other cases, Service Pack 3 (SP3) must be
used. 

Hardware Type Software Version Driver Version

Pika / Parrot PCI

1.0.1 - 1.0.1.1 Not supported
1.0.2 0.9.2.0
1.0.2.1 Not supported
1.0.3 - 1.0.3.3 0.10.0.0
1.0.4 - 1.0.4.1 Not supported
1.1 - 2.0 0.10.0.0
2.0.1 - 2.0.2.6 1.0.4.0
2.0.2.7 1.0.7.0
2.1 – 2.1.0.1 Not supported
2.1.0.3 – 3.0.3.1 1.0.7.0
3.0.3.1 Rev. A - current 1.0.10.0*

Parrot TOD

1.0.1 - 2.0 Not supported
2.0.1 – 2.0.2.6 1.0.4.0
2.0.2.7 1.0.7.0
2.1 1.0.4.0
2.1.0.1 – 3.0.3.1 1.0.7.0
3.0.3.1 Rev. A - current 1.0.10.0*

Parrot Modular
(Digital)

1.0.1 – 2.1.0.3.1 Not supported
2.1.0.4 – 3.0.3.1 1.0.7.0
3.0.3.1 Rev. A - current 1.0.10.0*

Parrot Modular
(Analog)

1.0.1 – 2.1.0.9 Not supported
3.0 - 3.0.3.1 1.0.7.0
3.0.3.1 Rev. A - current 1.0.10.0*

Parrot T1/E1 
Modular

1.0.1 – 3.0.1.1 Not supported
3.0.2 – 3.0.3.1 1.0.7.0
3.0.3.1 Rev. A - current 1.0.10.0*
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